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RESUMEN 

La formación de mielina en el sistema nervioso central (SNC) permite la regulación fina de 

la velocidad de conducción de los impulsos nerviosos y con ello la sincronización de los 

circuitos neuronales. En padecimientos neuropsiquiátricos como la esquizofrenia y el 

trastorno bipolar, existe una disfunción generalizada de la mielina, desde los niveles 

subcelular y celular, hasta el nivel del conectoma. En el SNC, sólo los oligodendrocitos 

maduros tienen capacidad mielinizante, por lo tanto, es necesario que ocurra un proceso 

de diferenciación y maduración a partir de las células precursoras de oligodendrocitos 

(OPCs), lo que se conoce como oligodendrogénesis. Tanto este proceso como el de 

mielinización son regulados mediante múltiples señales mediadas por contacto celular y por 

factores solubles. Una de las moléculas endógenas que puede modular estos procesos es 

la melatonina, ya que se ha documentado su efecto protector y reparador en modelos 

animales de daño a la materia blanca. El objetivo de este trabajo fue evaluar el efecto de la 

melatonina en la oligodendrogénesis y en la mielinización, en modelos in vitro. Para ello, se 

aislaron OPCs de corteza cerebral de ratas Wistar neonatas y se cultivaron con 

concentraciones fisiológicas de melatonina (1 y 100 nM) o el vehículo (etanol 0.0004%) 

durante 72h. Las células se fijaron y se inmunodetectó la proteína básica de mielina (MBP) 

como marcador de diferenciación. Se realizó una contratinción nuclear fluorescente. Para 

evaluar la mielinización, se realizó un cocultivo a partir de precursores neuronales y gliales 

de acuerdo con el método de Pang et al., (2012). Se adquirieron imágenes de microscopía 

de fluorescencia y de microscopía confocal, respectivamente. Se analizaron mediante el 

programa FIJI-ImageJ v1.53t y el macro MyelinJ. El análisis estadístico de los datos 

(ANOVA de una vía, Tukey post hoc) se realizó con JASP v0.16.4.0 y GraphPad Prism 

v9.5.1. En comparación con los cultivos incubados con el vehículo, la cantidad de células 

inmunopositivas a MBP fue significativamente mayor en presencia de melatonina 1nM 

(p<0.05). De manera similar, en presencia de melatonina 100 nM, el porcentaje de 

mielinización fue significativamente mayor (p<0.01). Los resultados indican que la 

melatonina estimula los procesos de diferenciación oligodendroglial y de mielinización en 

modelos in vitro. Esto es consistente con resultados previos que sugieren que la melatonina 

modula la reorganización del citoesqueleto oligodendroglial para favorecer una mayor 

complejidad morfológica, indispensable para su maduración. En conclusión, la melatonina 

en concentraciones fisiológicas induce la oligodendrogénesis y la mielinización, dos 

procesos clave en el desarrollo y la plasticidad del sistema nervioso central.                 

Palabras clave: Melatonina, Oligodendrogénesis, Mielinización, OPCs.  
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INTRODUCCIÓN 
 

Los oligodendrocitos, células gliales del sistema nervioso central (SNC), juegan un papel 

fundamental en la homeostasis de los circuitos neuronales. Su principal función es la 

producción de la vaina de mielina, una estructura formada por varias capas de membrana 

oligodendroglial envueltas alrededor de segmentos de los axones neuronales. Entre cada 

segmento mielinizado se forman los nodos de Ranvier, que son dominios axonales 

enriquecidos en canales iónicos específicamente distribuidos de manera que permiten la 

conducción saltatoria de los potenciales de acción (impulsos nerviosos). De esta manera, 

la conducción de los impulsos nerviosos se lleva a cabo a una mayor velocidad y con una 

mejor eficiencia con respecto a un axón no mielinizado. Los principales factores que influyen 

en la velocidad de transmisión de los impulsos nerviosos son: el diámetro de los axones, la 

longitud, el espesor y la compactación de la vaina de mielina, así como el número y la 

longitud de los nodos de Ranvier. Así, la mielinización permite regular finamente la 

velocidad de conducción de los impulsos nerviosos, y con ello se logra la sincronización de 

señales en los circuitos neuronales. 

Un oligodendrocito maduro es capaz de enrollar múltiples axones, esto se debe en gran 

parte a la dinámica del citoesqueleto oligodendroglial, en particular el citoesqueleto de 

actina, que es fundamental para llevar a cabo el proceso de mielinización, el cual es 

regulado de manera intrínseca por diversos factores celulares, y de manera extrínseca 

mediante factores solubles. Existe evidencia de que la mielina sufre modificaciones de 

forma continua en respuesta a demandas fisiológicas, sin embargo, es importante que el 

proceso mielinizante se lleve a cabo de forma correcta, ya que alrededor de la mitad del 

cerebro humano está compuesto por la materia blanca, formada principalmente por axones 

mielinizados y células gliales como los oligodendrocitos. El deterioro o daño a esta región 

está estrechamente relacionado con enfermedades neurodegenerativas como la esclerosis 

múltiple, lesiones en la medula espinal y leucoencefalopatía, e incluso trastornos 

psiquiátricos como la esquizofrenia y la depresión, entre otros.   

Uno de los factores solubles que podría modular el proceso de mielinización es la 

melatonina. Esta indolamina endógena tiene una fisiología muy versátil; entre las 

propiedades descritas para esta molécula destaca su capacidad antioxidante y moduladora 
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del citoesqueleto, del sistema inmune, y de diversos procesos de diferenciación celular. La 

melatonina también tiene un efecto neuroprotector, y en modelos de hipoxia/isquemia 

perinatal se ha observado que la administración de melatonina contrarresta el daño en la 

materia blanca.  

Antecedentes del grupo de trabajo sugieren fuertemente que la melatonina puede inducir el 

proceso de diferenciación oligodendroglial mediante su efecto sobre el citoesqueleto. En el 

presente estudio se evaluó el efecto de la melatonina en los procesos de 

oligodendrogénesis y mielinización in vitro, a través del análisis de imágenes de 

microscopía de fluorescencia de preparaciones que fueron realizadas con anterioridad. 

Para la evaluación del efecto sobre la oligodendrogénesis, se analizaron imágenes 

obtenidas de cultivos de células precursoras de oligodendrocitos (OPCs) de corteza 

cerebral de la rata, que se incubaron con diferentes concentraciones de melatonina y 

posteriormente se realizó una inmunodetección del marcador de diferenciación 

oligodendroglial MBP (proteína básica de mielina) y una contratinción nuclear. Para la 

evaluación de la mielinización in vitro, se analizaron imágenes provenientes de cultivos 

mixtos de precursores neuronales y gliales, que se estimularon con factores de crecimiento 

y los suplementos necesarios para inducir primero el desarrollo axonal y posteriormente la 

mielinización. En esta segunda fase se incubó con melatonina para evaluar su efecto, 

posteriormente se realizó una inmunodetección de MBP como marcador de los fragmentos 

mielinizados, de los neurofilamentos como marcador axonal y del factor de transcripción 

OLIG2 como marcador nuclear del linaje oligodendroglial. 
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REVISIÓN DE LITERATURA 
El sistema nervioso permite al organismo responder a estímulos externos, además tiene la 

capacidad de controlar e integrar diversas funciones de los demás órganos y sistemas. En 

general, puede dividirse en sistema nervioso central (SNC) y sistema nervioso periférico 

(SNP). El SNC está compuesto por el encéfalo y la médula espinal, los cuales están 

protegidos por el cráneo y las vértebras; rodeados además por tres membranas de tejido 

conjuntivo llamadas meninges. El encéfalo se divide en cerebro, cerebelo y tronco 

encefálico. La corteza cerebral forma la capa más externa del encéfalo, contiene la llamada 

“sustancia o materia gris” (debido al color gris de la corteza en un cerebro disecado en 

fresco) compuesta por somas neuronales, axones, dendritas y algunas células gliales 

(como astrocitos, oligodendrocitos, microglía y ependimocitos). En la parte interna del 

encéfalo se encuentra la “sustancia o materia blanca” formada principalmente por axones 

mielinizados (que en preparados frescos tienen un aspecto blanquecino), células gliales 

como oligodendrocitos, astrocitos y microglía, y vasos sanguíneos asociados (Figura 1). La 

médula espinal es una estructura cilíndrica que está en continuidad directa con el tronco 

encefálico y está organizada de forma inversa: en la parte interna se encuentra la sustancia 

gris y en la parte externa la sustancia blanca (Ross & Pawlina, 2015).  

 

Figura 1. Materia gris y blanca 
en el SNC. Corte coronal del 
cerebro humano en donde se 
muestra de forma general como 
está distribuida la materia gris 
(parte externa) y blanca (parte 
interna). Elaboración propia. 

 

 

Como ya se mencionó, el tejido nervioso está formado por neuronas y células gliales. Los 

componentes principales de una neurona son: el soma, las dendritas, el axón y las uniones 

sinápticas (Figura 2). El soma es la parte de la célula donde se encuentra el núcleo y varios 

otros organelos y tiene un alto nivel de actividad metabólica. Del soma parten dos tipos de 

prolongaciones o proyecciones especializadas: las dendritas, cuya principal función es 
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recibir los estímulos provenientes de otras neuronas, no están mielinizadas y forman 

múltiples arborizaciones que incrementan el área de superficie receptora. Por otra parte, el 

axón es una prolongación larga, que puede estar o no envuelta por una vaina de mielina 

producida por oligodendrocitos en el SNC y las células de Schwann en el SNP. Cada 

neurona tiene un solo axón, cuya principal función es transmitir estímulos a otra neurona o 

célula efectora (ej. célula muscular) en forma de impulsos nerviosos, los cuales constituyen 

la propagación de una señal electroquímica llamada “potencial de acción”. Este proceso 

implica una onda de despolarización de membrana en el segmento inicial del axón, en 

respuesta, se abren los canales de Na+ activados por voltaje. El ingreso de Na+ invierte o 

despolariza brevemente el potencial de membrana en reposo (-70 mV) a uno positivo (+30 

mV). Posteriormente, se cierran los canales de Na+ y se abren los canales de K+, una vez 

que los iones de potasio abandonan el axón la membrana vuelve a su potencial de reposo. 

Esta corriente local estimula las porciones adyacentes de la membrana del axón y repite la 

despolarización a lo largo de la membrana de éste (Bauer et al., 2009; Ross & Pawlina, 

2015).  

 

Figura 2. Esquema de la neurona 
y sus partes. La neurona es la 
unidad estructural y funcional del 
SNC. Del soma parten dos tipos de 
prolongaciones: dendritas y el axón. 
La mielina cubre de forma 
discontinua al axón, lo que genera 
los nodos de Ranvier. Elaboración 
propia. 

 

 

 

Los oligodendrocitos son células gliales. Su principal función es generar la vaina de mielina 

en el SNC, la cual está formada por capas concéntricas de membrana plasmática 

oligodendrocítica. Cada oligodendrocito emite varias prolongaciones que en sus extremos 

distales forman una especie de lengüetas que llegan hasta los axones y los envuelven por 

segmentos. Un oligodendrocito puede mielinizar a uno o varios axones. La vaina de mielina 

no cubre de forma continua a los axones, sino que existen espacios entre cada segmento 
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mielinizado, llamados “nodos de Ranvier”. Los nodos de Ranvier son dominios 

especializados del axón en los que se redistribuyen los canales iónicos de manera particular 

y la despolarización de la membrana puede ocurrir sólo en ellos. Así, el ensamblaje de los 

nodos de Ranvier es fundamental, ya que da origen al proceso denominado “conducción 

saltatoria o discontinua”, el cual incrementa la velocidad de transmisión del impulso nervioso 

y con ello la función del sistema. Los principales factores que influyen en modular la 

velocidad de transmisión de los impulsos nerviosos son el diámetro de los axones, la 

longitud, el espesor y la compactación de la vaina de mielina y el número y la longitud de 

los nodos de Ranvier (Fields, 2005, 2008; Ross & Pawlina, 2015). De esta manera, la 

mielinización permite la regulación fina de la velocidad de conducción del impulso nervioso 

y la sincronización de los circuitos neuronales.  

Figura 3. Principales 
células gliales del SNC. 
Las células gliales se 
diferencian por su forma, 
función y origen 
embrionario. Los 
astrocitos, en general, 
tienen forma de estrella y 
regulan la composición 
del medio que rodea a 
las neuronas. Los 

oligodendrocitos 
cumplen un papel 
fundamental en la 
síntesis y mantenimiento 
de la capa de mielina que 
cubre al axón. La 

microglía, células pequeñas que tienen funciones inmunitarias, son de origen embrionario 
diferente al de las neuronas, oligodendrocitos y astrocitos, y semejante al de las células del 
sistema inmune (González & Toro, 2007; Rela, 2016). 

 

La formación de la vaina de mielina, precedida por la migración de células precursoras de 

oligodendrocitos (OPCs, por sus siglas en inglés: oligodendrocyte precursor cells) desde la 

zona subventricular a diferentes regiones del cerebro y médula espinal, puede dividirse en 

tres partes: la primera comienza con la propagación celular, la cual también incluye una 

etapa de diferenciación caracterizada por la formación de prolongaciones celulares 

(procesos) y su ramificación, la segunda parte consiste en una mayor organización y 
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estabilización de las interacciones oligodendrocito-axón, así como la elaboración de las 

primeras láminas de membrana y las primeras envolturas y, finalmente, en la tercera parte 

comienza la compactación de las capas de mielina para formar una vaina madura (Figura 

4) (Bauer et al., 2009; Tomassy et al., 2016). 

 

Figura 4. Mielinización 
intrínseca (del 
neurodesarrollo).  

Las OPCs migran desde la zona 
subventricular hacia distintas 
regiones del cerebro y la medula 
espinal, sin embargo, las células 
migratorias pueden diferenciarse 
en oligodendrocitos maduros o 
solo proliferar. Imagen tomada de 
Bauer et al., 2009. 

 

 

 

 

La mielinización durante la edad adulta es un proceso dinámico que continuamente adapta 

y refina los circuitos del SNC en respuesta a demandas fisiológicas, además, es sensible a 

la experiencia social, así como a un ambiente enriquecido. La mielina puede sufrir 

modificaciones de tres formas (Figura 5); (1) se pueden agregar nuevos internodos, esto 

impulsado principalmente por la diferenciación de OPCs, sobre axones desmielinizados o 

áreas desmielinizadas de algunos axones, (2) puede haber modificaciones en internodos 

individuales, tanto en el grosor como en la longitud, además, (3) se puede modificar la 

arquitectura de los nodos de Ranvier e incrementar la densidad de los canales iónicos en 

el nodo (Bergles & Richardson, 2016; de Faria et al., 2021).  
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Figura 5. Mielinización adaptativa (remodelación). La mielina sufre modificaciones en su 
estructura (plasticidad) de acuerdo con las demandas fisiológicas y del ambiente. (1) 
Adición de nuevos internodos, mediado principalmente por OPCs que se diferencían y 
maduran; (2) remodelación de la mielina existente (alargamiento o retracción de internodos) 
mediado principalmente por oligodendrocitos maduros y (3) remodelación estructural de los 
nodos de Ranvier. Estos cambios pueden ocurrir en respuesta a la actividad neuronal y a 
la experiencia. Imagen modificada de Faria et al., 2021. 

 

Alrededor de la mitad del cerebro humano está compuesto por materia blanca, axones 

mielinizados y células gliales. Los daños o lesiones a esta región cerebral están asociados 

con enfermedades neurodegenerativas como esclerosis múltiple, lesiones en la médula 

espinal, leucoencefalopatía, incluso trastornos neurológicos caracterizados por afectar 

principalmente la materia gris como las enfermedades de Alzheimer, Parkinson y 

Huntington, muestran cambios claros en la materia blanca subcortical. Además, en diversos 

trastornos psiquiátricos como la esquizofrenia, el trastorno bipolar y la depresión se han 

reportado alteraciones estructurales y funcionales en la materia blanca (Fields, 2008; 

Valdés-Tovar et al., 2022). Es importante que el proceso de mielinización se lleve a cabo 

de una forma adecuada para un buen funcionamiento cerebral, ya que los defectos en la 

formación y el mantenimiento de la mielina conllevan a resultados clínicos devastadores. 

Los daños a la mielina, en general, se pueden ordenar dentro de tres categorías: pérdida 
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de mielina (desmielinización), producción anormal de mielina (dismielinización) y 

producción reducida de mielina (hipomielinización). Sin embargo, la hipermielinización 

también se ha descrito en ratones que sobreexpresan el gen de susceptibilidad a la 

esquizofrenia Nrg1 (Brinkmann et al., 2008). Además del proceso de remodelación o 

plasticidad de la mielina, existe un proceso endógeno de regeneración que se denomina 

remielinización. Este proceso a menudo resulta ineficiente en enfermedades como la 

esclerosis múltiple, en la cual la edad es uno de los factores importantes a considerar 

(envejecimiento), así como la entrada de los OPCs a un estado de inactividad (de Faria et 

al., 2021). Por otro lado, la remielinización parece ser efectiva en la adolescencia y la etapa 

adulta debido a que los OPCs son capaces de responder a los daños en la mielina (Figura 

6). Similarmente al proceso de remodelación, la remielinización también aumenta con el 

aprendizaje de tareas complejas como estudiar un segundo idioma, hacer malabares, 

aprender a tocar el piano; actividades que no solo abarcan habilidades motoras, si no 

también sensoriales y cognitivas (Saab & Nave, 2017; Tomassy et al., 2016). 

 

Figura 6. Remielinización. Los axones 
son mielinizados por oligodendrocitos 
maduros, sin embargo, si ocurre un daño, 
el oligodendrocito muere y la mielina se 
desintegra. Posteriormente, inicia una 
etapa de reclutamiento de OPCs y 
eliminación de los restos de mielina por 
parte de la microglía. Los OPCs que 
migran y los que ya están en el área 
dañada empiezan a proliferar y a 
continuación inicia la etapa de 
diferenciación y maduración 
oligodendroglial. Finalmente, en la etapa 
de remielinización, los oligodendrocitos 
maduros generan la mielina faltante. 
Imagen modificada de Faria et al., 2021. 
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La diferenciación y maduración oligodendroglial, también llamada oligodendrogénesis, es 

indispensable para los procesos de mielinización y de remielinización, ya que sólo los 

oligodendrocitos maduros tienen capacidad mielinizante. Durante dicho proceso, existen 

varios estadios de diferenciación, de acuerdo con la capacidad migratoria, de proliferación 

y de cambios en la complejidad morfológica y la expresión de marcadores moleculares 

específicos. La oligodendrogénesis se puede dividir en cuatro estadios: desde OPCs, los 

preoligodendrocitos, los oligodendrocitos inmaduros y los oligodendrocitos maduros (Figura 

7) (Barateiro et al., 2016; Barateiro & Fernandes, 2014). 

 

Figura 7. Estadios de la oligodendrogénesis. Los cambios en cada estadio se definen 
de acuerdo con el aumento en la complejidad morfológica, la expresión de marcadores 
moleculares, la habilidad para migrar, proliferar y diferenciarse. Imagen modificada de  
Barateiro & Fernandes, 2014. 

 

Como se mencionó, el aumento en la complejidad morfológica es clave en el proceso de 

maduración oligodendroglial. Estos cambios morfológicos son regulados por el 

citoesqueleto, en particular, por dos de sus componentes primordiales: los microtúbulos 

(MT) y los microfilamentos (MF) (Figura 8), que, además, fungen como vías de transporte 
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de organelos, vesículas y proteínas. Los MT están formados por heterodímeros de las 

subunidades proteicas de α- y β-tubulina, las cuales al unirse generan una estructura 

cilíndrica. En el cuerpo celular se organizan para formar un patrón en forma de malla, 

mientras que en la periferia forman filamentos paralelos al eje principal de una prolongación. 

Los oligodendrocitos expresan βIV-tubulina, una forma específica de β-tubulina encontrada 

sólo en estas células. Esta proteína se localiza en la región proximal de las prolongaciones 

de oligodendrocitos premielinizantes, así como en las regiones distales de las 

prolongaciones en células mielinizantes. La presencia de una isoforma específica de 

tubulina denota la importancia del citoesqueleto oligodendroglial durante los diferentes 

estadios de diferenciación (Bauer et al., 2009; Lunn et al., 1997; Terada et al., 2005).  

La tubulina puede tener diversas modificaciones postraduccionales, tales como acetilación 

y tirosinación en la subunidad alfa y fosforilación, poliglutamilación y poliglicilación en 

ambas subunidades. Los oligodendrocitos contienen α-tubulina acetilada y tirosinada tanto 

en el cuerpo celular como en sus prolongaciones, la única diferencia es la ausencia de α-

tubulina en los extremos más distales de las prolongaciones. Además, la acetilación de α-

tubulina se relaciona con la estabilidad de las prolongaciones en oligodendrocitos maduros, 

por ello, durante la etapa de diferenciación en donde se requiere mayor dinámica 

microtubular, es necesario que la tubulina sea desacetilada, dicho proceso es llevado a 

cabo por la enzima reguladora de información silenciosa tipo 2 (SIRT2). La expresión de 

dicha enzima se relaciona con cambios morfológicos, procesos de ramificación y un 

incremento en la expresión de la 2’,3’-nucleótido cíclico 3’-fosfodiesterasa (CNP), lo que 

ocurre cuando las células se encuentran en un estado de premielinización. La tirosinación 

de la α-tubulina en su extremo C-terminal conduce a la asociación de los microtúbulos con 

proteínas conectoras citoplasmáticas (CLIP), esta unión podría servir como un puente entre 

microtúbulos y microfilamentos para la formación de filopodios y lamelipodios. Los MT se 

propagan y extienden dentro de los dominios ricos en MF, sin embargo, cercanos a la parte 

más distal de una prolongación comienzan a disminuir. De manera similar, los cambios en 

la conformación de la membrana plasmática que acompañan a la ramificación de una 

prolongación dependen de la disposición de los MF (Akhmanova & Hoogenraad, 2005; 

Bauer et al., 2009; Li et al., 2007; Lunn et al., 1997; Song et al., 2001). Existen varias 

proteínas asociadas que se unen y estabilizan a los microtúbulos polimerizados y cambian 

la dinámica de polimerización/despolimerización. Las proteínas asociadas a microtúbulos 

(MAPs, por sus siglas en inglés: microtubule-associated protein), están implicadas en los 

procesos de transducción de señales y participan en la interacción de los microtúbulos con 
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otros componentes del citoesqueleto, además, son importantes en el anclaje de cinasas y 

fosfatasas, así como en el transporte vesicular. En oligodendrocitos se expresan 

principalmente la MAP1B, MAP2C y MAP4 (Bauer et al., 2009; Black et al., 1994; 

Vouyiouklis & Brophy, 1995). 

Los MF se localizan debajo de la membrana plasmática, tanto en el cuerpo celular como en 

las prolongaciones de los oligodendrocitos, particularmente en el área donde se forman 

nuevas prolongaciones. La actina, como proteína de unión a ATP, está presente en dos 

estados: como monómeros globulares (G-actina) o como polímeros filamentosos (F-actina), 

esta última se concentra principalmente en las puntas de nuevas prolongaciones, así como 

en filopodios delgados. En los oligodendrocitos, los MF desempeñan un papel importante 

en el proceso de extensión de las prolongaciones o procesos, ya que las primeras 

protrusiones son formadas por la polimerización de filamentos individuales que 

posteriormente resultan en la aparición de filopodios y lamelipodios. Los filopodios son 

estructuras estrechas de actina dispuesta en haces paralelos, mientras que los lamelipodios 

son estructuras más amplias que contienen mallas de actina organizadas de forma 

ortogonal. En general, la formación de estas estructuras es catalizada por proteínas de 

unión a actina, tales como la proteína relacionada con actina 2/3 (Arp2/3), la proteína Spire 

y la proteína Cobl (Cordon-Bleu) (Qualmann & Kessels, 2008; Rumsby et al., 2003; Simpson 

& Armstrong, 1999; Song et al., 2001). 

Las proteínas asociadas a actina en general comparten la habilidad de interactuar con los 

MF, sin embargo, los mecanismos de unión son diferentes. En oligodendrocitos, la miosina-

IIB interactúa con los MF, la cual permite a los MF formar lamelipodios. Las proteínas 

Mayven (KLHL2) y MRP2 son proteínas que presentan una distribución y función similar, 

además, se expresan en todos los estadios de desarrollo y están distribuidas a lo largo de 

las prolongaciones de los oligodendrocitos (Jiang et al., 2005, 2007). Ermin es otra proteína 

que se expresa relativamente tarde en el proceso de mielinización, se localiza en zonas 

específicas que emanan del cuerpo celular y participa en el entrecruzamiento de proteínas 

de membrana y del citoesqueleto. En oligodendrocitos cultivados, Ermin se presenta en los 

bucles paranodales no compactados y en la capa externa de la vaina de mielina in vivo, lo 

que podría sugerir que dicha proteína participa en el reordenamiento al final del proceso de 
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envoltura o durante la compactación de la vaina de mielina (Bauer et al., 2009; 

Brockschnieder, 2006).  

Figura 8. Citoesqueleto oligodendroglial. Formación de los procesos regulada por la 
polimerización de MF, lo que conduce a la formación de filopodios, los cuales son mediados 
por el complejo Arp2/3 para ensancharse y extenderse y formar lamelipodios. Imagen 
modificada de Bauer et al., 2009. 

 

En el SNC, existen proteínas específicas que forman parte de la estructura de la mielina, 

algunas de ellas están asociadas con el citoesqueleto oligodendroglial y regulan su función. 

La proteína básica de mielina (MBP, por sus siglas en inglés: myelin basic protein) es la 

segunda proteína más abundante, después de la proteína proteolipídica (PLP). En el SNC, 

induce la polimerización de F-actina, así como el agrupamiento de MF. La fosforilación de 

la MBP determina su ubicación, ya que puede encontrarse tanto en el cuerpo celular como 

en la vaina de mielina. En etapas posteriores del proceso de mielinización, la MBP se 

encuentra desfosforilada, lo que permite su interacción con lípidos de membrana y su papel 

como proteína de anclaje para actina, sin embargo, la función principal de dicha proteína 

es la compactación de la vaina de mielina, ya que permite interconectar las membranas de 

las capas de mielina sobre su superficie intracelular (Bates et al., 2003; Boggs, 2006).  

La CNP en oligodendrocitos promueve el proceso de extensión de sus prolongaciones. Esta 

proteína aumenta su expresión en la etapa de premielinización y se mantiene en niveles 

elevados durante y después de la mielinización, además, se une a MT y MF. La CNP induce 

la reorganización del citoesqueleto para formar protrusiones de membrana ricas en F-actina 

que después son invadidas por MT (Bauer et al., 2009; Lee et al., 2005). Otra proteína 

Filopodios Lamelipodios 
Filamentos de actina 
Microtúbulos 
Complejo Arp2/3 
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específica de mielina es la glicoproteína oligodendrocítica de mielina (MOG, por sus siglas 

en inglés: Myelin oligodendrocyte glycoprotein). Es una proteína integral de la membrana 

de los oligodendrocitos, con un dominio tipo inmunoglobulina (Ig) extracelular, lo que 

sugiere una función de adhesión celular. Está localizada en las láminas externas de la vaina 

de mielina. La expresión de MOG comienza en una etapa tardía en comparación con otras 

proteínas de mielina, debido a esto MOG es un marcador para identificar a un 

oligodendrocito maduro. Esta proteína no interactúa de forma directa con el citoesqueleto, 

sin embargo, regula la estabilidad de MT a través de la MBP (Bauer et al., 2009; Pham-Dinh 

et al., 1993; Reindl & Waters, 2019). Por último, la glicoproteína asociada a mielina (MAG, 

por sus siglas en inglés: Myelin-associated glycoprotein) constituye entre el 0.1 y el 1% de 

todas las proteínas de mielina en el SNC. Se expresa en dos isoformas, las cuales difieren 

en su dominio extracelular; L-MAG y S-MAG. Esta proteína desempeña un papel importante 

en el mantenimiento de la integridad de la mielina en el SNC y participan en el anclaje de 

los internodos al axón (Schachner & Bartsch, 2000).  
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Figura 9. Proteínas de la mielina. En el SNC, existen proteínas específicas de mielina 
asociadas al citoesqueleto oligodendroglial; la proteína básica de mielina (MBP), 2’,3’-
nucleótido cíclico 3’-fosfodiesterasa (CNP), la proteína proteolipídica (PLP), la glicoproteína 
oligodendrocítica de mielina (MOG), la glicoproteína asociada a mielina (MAG), y Ermin. 
Imagen modificada de Valdés-Tovar et al., 2022. 

 

Tanto la oligodendrogénesis como la mielinización son procesos cuyas diferentes etapas 

son reguladas mediante diversos factores celulares, entre ellos se han identificado factores 

de transcripción, proteínas remodeladoras de cromatina y ARN no codificante; sin embargo, 

además de estos factores intrínsecos, proteínas asociadas a la membrana, factores 

solubles y proteínas de la matriz extracelular están involucrados de manera positiva o 

negativa en la regulación de los diferentes estadios de proliferación, diferenciación y 

maduración oligodendroglial y la mielinización (Tomassy et al., 2016). 

Entre las moléculas endógenas que podría modular los procesos de diferenciación de 

oligodendrocitos y la formación de mielina está la melatonina. Ésta es una indolamina 

endógena con una fisiología muy versátil. Entre sus funciones, datos experimentales 

obtenidos en varios modelos de animales recién nacidos con lesiones cerebrales respaldan 

la noción de un efecto neuroprotector (Biran et al., 2014) , además, la melatonina ha sido 

caracterizada como uno de los factores que modulan la neuroplasticidad (neurogénesis, 

dendritogénesis, axonogénesis, sinaptogénesis), así como el rol de los receptores de 

melatonina (MT1 y MT2) y las vías de señalización subyacentes a los efectos moduladores 

en la neuroplasticidad (Valdés-Tovar et al., 2018). Es capaz de actuar como un modulador 

de los cambios dinámicos y diferenciales en la organización del citoesqueleto de diversas 

estirpes celulares (Benitez-King, 2006). 

La síntesis de melatonina en la glándula pineal ocurre durante la noche, es decir, durante 

la fase de oscuridad del ciclo de iluminación ambiental, y la sincronización del ritmo 

circadiano de su síntesis con respecto al ciclo luz/oscuridad ocurre a través del tracto 

retinohipotalámico. Durante la fase de oscuridad, la unión de la noradrenalina a sus 

receptores específicos situados en las membranas de los pinealocitos promueve la 

activación de la síntesis de melatonina; su formación comienza con la captación del 

aminoácido triptófano, procedente del torrente circulatorio. Este aminoácido es hidroxilado 

en la mitocondria por la triptófano-hidroxilasa. La mayor parte del 5-hidroxitriptofano 

resultante se convierte a serotonina en el citosol, posteriormente, la serotonina es N-

acetilada y se convierte en N-acetilserotonina; precursor que es O-metilado por la 
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hidroxiindol-O-metiltransferasa, lo que da lugar a la melatonina. La melatonina puede unirse 

a receptores de la membrana plasmática, sin embargo, su carácter lipofílico le permite 

entrar fácilmente en la célula, e incluso, llegar hasta el núcleo. Se une a los receptores de 

membrana MT1 y MT2, acoplados a proteínas G y en anfibios y aves se ha caracterizado un 

tercer sitio de unión llamado MT3 con actividad de quinona reductasa (Guerrero et al., 2007; 

Gunata et al., 2020). 

 

Figura 10. Principales mecanismos de acción de la melatonina. La melatonina puede unirse 
a receptores de la membrana plasmática. El receptor MT1 ha sido identificado en el núcleo 
supraquiasmático, los vasos sanguíneos del corazón y cerebro. El MT2 se localiza 
principalmente en el hipotálamo, la retina, los riñones y el tejido cardíaco. El MT3 muestra 
similitudes con respecto al MT2 en términos de anclaje. RORα, RORβ and RORγ son sitios 
de unión nucleares (NRs, por sus siglas en inglés: nuclear receptors), dentro de sus 
funciones principales esta la regulación metabólica, reacción inmune y están involucrados 
en la respuesta ante el estrés (Guerrero et al., 2007; Gunata et al., 2020). Imagen tomada 
de Guerrero et al., 2007. 

 

La melatonina puede contribuir a la sincronización de los ritmos circadianos, una 

característica importante para el tratamiento de trastornos del estado de ánimo, en donde 

el desacoplamiento en los ritmos circadianos prevalece. En pacientes con estos trastornos 
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los niveles de melatonina disminuyen. En parte, esta disminución puede deberse a la 

respuesta inflamatoria mediada por la infiltración de células inmunes a través de la barrera 

hematoencefálica y el aumento de proteínas proinflamatorias. Por otro lado, la disminución 

en los niveles de melatonina puede estar relacionado con una variación genética de la 

enzima N-acetilserotonina O-metiltransferasa. La melatonina puede incrementar la 

expresión de los genes Per1 y Per2, los cuales juegan un papel fundamental en el reinicio 

del reloj circadiano. Además, funge como un neutralizador directo de radicales libres y 

potencia el efecto de antioxidantes clásicos e induce la expresión de enzimas antioxidantes. 

En mamíferos, el control central de los ritmos circadianos es ejercido por el núcleo 

supraquiasmático, que está sincronizado por los niveles lumínicos ambientales percibidos 

por la retina y extiende su sincronización al resto del organismo mediante la síntesis rítmica 

de melatonina (Guerrero et al., 2007; Valdés-Tovar et al., 2018). 

Como se mencionó previamente, los efectos como modulador del citoesqueleto y como un 

factor de diferenciación de diversas estirpes celulares, hacen de la melatonina una molécula 

idónea para modular la oligodendrogénesis y la mielinización. En este contexto, existen 

evidencias de modelos animales de hipoxia y/o isquemia perinatal en los que la 

administración de melatonina atenúa el daño de la materia blanca (Kaur et al., 2010; Miller 

et al., 2014; Olivier et al., 2009; Villapol et al., 2011). En estos estudios se observó que la 

melatonina no induce la proliferación de los precursores de oligodendrocitos, por lo que los 

autores sugieren que esta indolamina podría favorecer la maduración de éstos, y que su 

efecto podría estar mediado, al menos parcialmente, por sus receptores de membrana 

(Olivier et al., 2009). Además, se ha demostrado la habilidad de la melatonina para disminuir 

la desmielinización y mejorar la remielinización a través de sus efectos sobre la actividad 

locomotora de ratones con esclerosis múltiple (Abo Taleb & Alghamdi, 2020). En estos 

modelos, parte del efecto de la melatonina puede atribuirse a los mecanismos que reducen 

los moduladores de la inflamación, así como también sus efectos antioxidantes, los cuales 

reducen la formación de radicales libres (Kaur et al., 2010; Villapol et al., 2011). 

Planteamiento del problema 

Si bien se sabe que la melatonina tiene efectos moduladores sobre el citoesqueleto y sobre 

procesos de diferenciación celular en diversas estirpes, y que puede tener un efecto de 

protección y/o revertir los efectos del daño en la materia blanca cerebral en varios modelos 

animales, no se sabe cuál es la participación de esta indolamina, en concentraciones 

fisiológicas, en la diferenciación oligodendroglial y en la mielinización en el SNC. 
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OBJETIVOS 

Objetivo general 

Evaluar el efecto de la melatonina en los procesos de oligodendrogénesis y mielinización 

del SNC, en modelos in vitro, mediante el análisis de imágenes de microscopía de 

fluorescencia.  

Objetivos particulares 

1. Evaluar el efecto de la melatonina en la oligodendrogénesis a partir de precursores 

celulares aislados. 

2. Evaluar el efecto de la melatonina en la mielinización en un modelo in vitro de cocultivo. 

 

METODOLOGÍA 

Evaluación del efecto de la melatonina en la oligodendrogénesis 

Previamente se desarrollaron cultivos de OPCs, aislados de corteza cerebral de ratas 

Wistar mediante el método de (McCarthy & de Vellis, 1980) (n=8), que se estimularon con 

melatonina 1 y 100 nM [concentraciones semejantes a las reportadas en el SNC (Reiter, 

1993; Tan et al., 2016) durante tres días. Transcurrido el tiempo de incubación, las células 

fueron fijadas y se realizó una inmunodetección fluorescente del marcador de diferenciación 

oligodendroglial MBP y una contratinción nuclear. Posteriormente, se obtuvieron imágenes 

de microscopía de fluorescencia de al menos 8 campos al azar. Se cuenta con al menos 27 

imágenes por grupo experimental. 

El análisis de las imágenes obtenidas se llevó a cabo mediante el software Image J. En total 

se analizaron 95 imágenes, divididas en dos canales: en el canal azul se contabilizaron los 

núcleos celulares contrateñidos con el compuesto DAPI y en el canal verde de cada imagen, 

se contaron las células inmuno-positivas a MBP. Los datos se concentraron en un archivo 

de Excel, organizados en columnas correspondientes al tratamiento, el número de núcleos 

y el número de células MBP (+). En esta base de datos el tratamiento 1 corresponde al 

vehículo o control (VEH), el tratamiento 2 a melatonina 1 nM (MEL 1 nM) y el tratamiento 3 

a melatonina 100 nM (MEL 100 nM). El análisis estadístico de los datos obtenidos se realizó 

en JASP versión 0.16.4.0 mediante un ANOVA de una vía, y las diferencias entre los grupos 



 

18 
 

se establecieron mediante la prueba post hoc de Tukey. Se consideró diferencia 

significativa con una p < 0.05. 

Evaluación de la mielinización in vitro 

Por otra parte, para la evaluación de la mielinización in vitro, se desarrollaron cultivos mixtos 

de células de la corteza cerebral (n=8 ratas) que se estimularon con los factores de 

crecimiento y suplementos necesarios para el desarrollo axonal y posteriormente para 

inducir la mielinización (Pang et al., 2012).Los cultivos se estimularon durante 13 días con 

las concentraciones molares de melatonina mencionadas previamente para evaluar su 

efecto sobre la mielinización. Al cabo del tiempo de incubación los cultivos se fijaron y se 

realizó una inmunofluorescencia triple para detectar axones (neurofilamentos), 

proyecciones oligodendrogliales y tractos mielinizados (MBP) y núcleos positivos a OLIG2, 

un marcador de linaje oligodendroglial. 

Se adquirieron al menos 42 imágenes de microscopía confocal de cada grupo experimental 

(4 cubreobjetos de cada grupo), mediante un microscopio ZEISS LSM900 con Airyscan2 y 

el software Zen versión 3.3 (blue edition). Cada imagen se compuso de 6 regiones contiguas 

(tiles) de 491.5 x 491.5 µm y 7 secciones ópticas (slices) obtenidas con un intervalo de 0.38 

µm, para abarcar un total de 2.28 µm. Mediante las funciones de procesamiento de 

imágenes del software Zen 3.3, se hizo el empalme de las regiones contiguas con la función 

Stitching, para lo que se tomó como referencia el canal azul correspondiente a los axones. 

Posteriormente, se hizo un empalme de las secciones ópticas mediante la función Extended 

Depth of Focus mediante el método de Maximum projection, y dichas imágenes se 

procesaron mediante el software Image J versión 1.53t de la siguiente manera: 

File → Open: buscar el archivo correspondiente en las carpetas → Abrir 

Series 1 → OK   Esta función abre los 3 canales de la imagen [verde: MBP, azul: 

neurofilamentos (NF), rojo: núcleos]. El plugin de análisis MyelinJ sólo trabaja con los 

canales correspondientes a los axones y la mielina (azul y verde, respectivamente) por lo 

que se cerró el canal rojo en todos los casos. 

Image → Type → 8-bit 

Image → Adjust → Brightness-Contrast: para cada canal se aplicó la función Auto → Apply 

→OK 

Image → Color → Merge Channels: C=0 green; C=1 blue → Create Composite → OK 
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Image → Type → RGB Color 

File → Save as → Tiff… 

Los archivos de imagen se guardaron organizados en carpetas diferentes según el 

tratamiento y esas carpetas a su vez dentro de una carpeta general llamada Confocal 

cultivos. 

A continuación, se utilizó el plugin denominado MyelinJ (desarrollado para uso con el 

software Fiji-ImageJ) (Whitehead et al., 2019); para el análisis de las imágenes. Para ello 

en ImageJ se elige la pestaña Plugins → MyelinJ-master → MyelinJ.  En el primer cuadro 

de opciones se elige el nombre de un archivo con extensión .csv para que se guarden los 

datos, y se elige nuevo usuario y la opción de condiciones experimentales múltiples: 

 

 

 

 

 

En el siguiente cuadro de opciones el programa solicita las condiciones en las que 

procesará las imágenes correspondientes al canal de mielina: 

 

 

 

 

 

 

 

Posteriormente se definen las condiciones para el canal correspondiente a los axones: 

Choose user name 

 Jesus.csv 

✓ New user? 

✓ Multiple experimental conditions?  

OK 

 

Settings for myelin 

Background  

✓ CLAHE? 

✓ Subtract background (using 

neurites)? 

NEXT 
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Una vez establecidas dichas condiciones de análisis, el plugin MyelinJ procesa todas las 

imágenes contenidas en las carpetas y arroja los datos correspondientes (% myelination, 

% neurite density) en archivos .csv, así como las imágenes resultantes de cada canal 

después del procesamiento realizado. 

Los datos se concentraron en un solo archivo .csv de manera ordenada, en tres columnas 

correspondientes al tratamiento, el porcentaje de mielinización (% myelination) y el 

porcentaje de densidad axonal (% neurite density). Esta base de datos se analizó mediante 

el programa GraphPad Prism versión 9.5.1 y el programa JASP versión 0.16.4.0 

En el programa GraphPad Prism se realizó un análisis de datos extremos, se retiraron 

dichos datos y se hizo una prueba de Kolmogorov Smirnoff. Los datos tuvieron una 

distribución normal, por lo que se procedió a realizar un ANOVA de una vía y una prueba 

post hoc de Tukey. Se consideró diferencia significativa con una p < 0.05. 

 

 

Settings for dense neurites 

Normalise local contrast 

Standard deviation 0.5 → Sparse neurites 

 

Settings sparse neurites 

Background 

✓ Subtract background? 

Threshold method 

Default 

Min: 12   Max: 255   → Apply 

Set for analysis 

Start analysis 
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RESULTADOS 

Efecto de la melatonina sobre la diferenciación de las células precursoras de 

oligodendrocitos (oligodendrogénesis) 

Los siguientes resultados corresponden al análisis de 95 imágenes mediante el software 

Image J. Se determinó el número de núcleos teñidos con el compuesto DAPI y el número 

de células inmuno-positivas a MBP: MBP(+). En la Tabla 1 se muestra la estadística 

descriptiva obtenida del análisis de los datos mediante el software Jasp. 

Tabla 1. Número de núcleos y células inmunopositivas a MBP tras la incubación con MEL 
por 72h. 

 Núcleos Células MBP (+) 

Tratamiento VEH MEL 1 nM MEL 100 nM VEH MEL 1 nM MEL 100 nM 

n (imágenes) 31 37 27 31 37 27 

Media 107 126 117 14 23 20 

Mediana 97 112 107 13 21 19 

Desviación estándar 56 51 52 9 13 9 
 

A 
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B 

 

A 

 

 

 

 

 

 

 

 

Figura 1. Determinación del número de núcleos teñidos con DAPI para cada 
tratamiento. En el panel A se muestra un gráfico de tipo caja y bigote y en el panel B un 
gráfico de tipo nube de lluvia (raincloud plot). Ambos gráficos permiten apreciar la 
dispersión y distribución de los datos. 
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B 

En las figuras 1 y 2 se muestran gráficos de tipo caja y bigote (panel A) y de tipo nube de 

lluvia (raincloud plot) (panel B), de los datos correspondientes al conteo de núcleos 

celulares y células positivas a MBP, respectivamente, para los tres tratamientos. 

Tabla 2. Análisis de la varianza (ANOVA) de una vía para los datos correspondientes a los 
núcleos. 

ANOVA- Núcleos 

 Suma de 

cuadrados 

Grados de 

libertad 

Cuadrado de 

la media 

F p 

Tratamiento 6192.340 2 3096.170 1.094 0.339 

Residuales 260286.544 92 2829.202   

 

El resultado de este análisis indica que no hay una diferencia significativa en el número de 

núcleos teñidos con DAPI entre las imágenes provenientes de los distintos tratamientos (F 

(2,92) = 1.09, p = 0.33).  

Figura 2. Determinación del número de células inmunopositivas a MBP para cada 

tratamiento. En el panel A se muestra un gráfico de tipo caja y bigote y en el panel B un 

gráfico de tipo nube de lluvia (raincloud plot) del número de células inmunopositivas a 

MBP. Ambos gráficos permiten apreciar la dispersión y distribución de los datos. 
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Figura 3. Cuantificación de núcleos celulares y células inmunopositivas a MBP. Imágenes 
representativas de las células precursoras de oligodendrocitos que fueron incubadas con el vehículo 
(VEH), melatonina 1 nM (MEL 1 nM) o melatonina 100 nM (MEL 100 nM) durante 72 h. Se realizó 
una tinción nuclear fluorescente con el compuesto DAPI (color azul, imágenes del panel izquierdo) y 
una detección inmunofluorescente de MBP (color verde; imágenes del panel derecho).  
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Tabla 3. Análisis de la varianza (ANOVA) de una vía para los datos correspondientes al número 
de células inmunopositivas a MBP. 

ANOVA- MBP (+) 

 Suma de 

cuadrados 

Grados de 

libertad 

Cuadrado de 

la media 

F p 

Tratamiento 1404.616 2 702.308 6.023 0.003* 

Residuales 10727.005 92 116.598   

*p<0.05 

Por otra parte, en el ANOVA realizado para el número de células inmunopositivas a MBP 

se encontraron diferencias significativas entre los tratamientos (F (2,92) = 6.02, p = 0.003). 

Tras verificar el supuesto de homogeneidad de varianzas de los grupos con la prueba de 

Levene (F (2,92) = 2.23, p = 0.113), se realizó el análisis post hoc mediante la prueba de 

Tukey, que muestra que sólo hay diferencias significativas entre el grupo VEH y el 

tratamiento con MEL 1 nM (p = 0.002) (Figura 4). 

 

 

 

 

 

Figura 4. Efecto de la melatonina 
sobre el número de células 
inmunopositivas a MBP. Las 
células precursoras de 
oligodendrocitos fueron incubadas 
durante 72 h con el vehículo (VEH), 
melatonina 1 nM (MEL 1 nM) o 
melatonina 100 nM (MEL 100 nM). 
La proteína MBP se detectó 
mediante inmunofluorescencia 
indirecta. Los datos representan la 
media ± el error estándar de la media 
(eem) de los datos obtenidos del 
análisis de al menos 27 imágenes 
por tratamiento. ANOVA de una vía, 
prueba post hoc Tukey;  ** p<0.01 
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Efecto de la melatonina sobre la mielinización in vitro 

Los siguientes resultados corresponden al análisis de 129 imágenes, de las cuales al menos 

41 imágenes corresponden a cada grupo experimental, mediante el plugin MyelinJ del 

software ImageJ. Los datos extremos detectados en el primer análisis realizado mediante 

el software GraphPad Prism fueron eliminados. En la Tabla 4 se muestra la estadística 

descriptiva obtenida del análisis posterior de los datos mediante el software Jasp. 

Tabla 4. Estadística descriptiva correspondiente al porcentaje de densidad axonal y al 
porcentaje de mielinización obtenidos mediante el plugin MyelinJ. 
  

 % densidad axonal % mielinización 

Tratamiento VEH MEL 1 nM MEL 100 nM VEH MEL 1 nM MEL 100 nM 

n (imágenes) 44 39 39 41 36 36 
Datos extremos 

eliminados 1 2 2 4 5 7 

Mediana 13.221 12.048 12.048 5.229 7.695 7.798 

Media 13.959 11.962 11.962 6.034 7.263 7.557 
Error estándar de la 

media 1.041 0.720 0.720 0.499 0.322 0.268 

Desviación estándar 6.902 4.496 4.496 3.194 1.931 1.606 
 

A 
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B 

 

La prueba de homogeneidad de varianzas de Levene aplicada a los datos de la evaluación 

del porcentaje de densidad axonal en las imágenes de los distintos tratamientos arroja una 

diferencia significativa (F (2,122) = 6.027, p = 0.003), por lo que al realizar el ANOVA de 

una vía se aplicó la corrección de Brown-Forsythe.  

Tabla 5. Análisis de la varianza (ANOVA) de una vía para los datos correspondientes al 
porcentaje de densidad axonal evaluado mediante el programa MyelinJ 

ANOVA- % densidad axonal 

Corrección 

homogeneidad 

de varianzas 

 Suma de 

cuadrados 

Grados 

de 

libertad 

Cuadrado 

de la media 

F p 

Ninguna Tratamiento 208.976 2.000 104.488 6.023 0.033* 

Residuales 3636.010 122.000 29.803   

Brown-

Forsythe 

Tratamiento 208.976 2.000 104.488 3.600 0.031* 

Residuales 3636.010 106.808 34.043   

*p < 0.05 

Figura 5. Evaluación de la densidad axonal en los cocultivos incubados con 
melatonina. En el panel A se muestra un gráfico de tipo caja y bigote y en el panel B un 
gráfico de tipo nube de lluvia (raincloud plot). Ambos gráficos permiten apreciar la 
dispersión y distribución de los datos correspondientes al porcentaje de densidad axonal 
evaluado mediante el programa MyelinJ. 
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Se realizó la prueba post hoc de Tukey, que indica que hay una diferencia significativa entre 

los tratamientos VEH y MEL 100 nM (p=0.028).  

 

En cuanto a la evaluación del porcentaje de mielinización en las imágenes analizadas, se 

obtuvieron los siguientes resultados: 

A 

 

Figura 6. Efecto de la 
melatonina sobre el porcentaje 
de densidad axonal. Los 
cocultivos fueron incubados 
durante 13 días con el vehículo 
(VEH), melatonina 1 nM (MEL1) o 
melatonina 100 nM (MEL100). 
Los neurofilamentos  se 
detectaron como marcador axonal 
mediante inmunofluorescencia 
indirecta. Se representan los 
datos obtenidos del análisis de al 
menos 39 imágenes por 
tratamiento. ANOVA de una vía, 
prueba post hoc Tukey;  * p<0.05 
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B 

 

La prueba de homogeneidad de varianzas de Levene aplicada a los datos de la evaluación 

del porcentaje de mielinización en las imágenes de los distintos tratamientos arroja una 

diferencia significativa (F (2,110) = 8.094, p < 0.001), por lo que al realizar el ANOVA de 

una vía se aplicó la corrección de Brown-Forsythe.  

Tabla 6. Análisis de la varianza (ANOVA) de una vía para los datos correspondientes al 
porcentaje de mielinización evaluado mediante el programa MyelinJ. 
 

ANOVA- % mielinización 

Corrección 

homogeneidad 

de varianzas 

 Suma de 

cuadrados 

Grados 

de 

libertad 

Cuadrado 

de la media 

F p 

Ninguna Tratamiento 50.997 2.000 25.499 4.461 0.014* 

Residuales 628.761 110.000 5.716    

Brown-

Forsythe 

Tratamiento 50.997 2.000 25.499 4.723 0.011* 

Residuales 628.761 87.745 7.166   

*p < 0.05 

Figura 6. Evaluación de la mielinización en los cocultivos incubados con 
melatonina. En el panel A se muestra un gráfico de tipo caja y bigote y en el panel B un 
gráfico de tipo nube de lluvia (raincloud plot). Ambos gráficos permiten apreciar la 
dispersión y distribución de los datos correspondientes al porcentaje de mielinización 
evaluado mediante el programa MyelinJ. 
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Se realizó la prueba post hoc de Tukey, que indica que hay una diferencia significativa entre 

los tratamientos VEH y MEL 100 nM (p=0.017).  

 

 

 

 

 

 

 

 

 

 

 

En la figura 7 se muestran imágenes representativas de los cocultivos tratados con el 

vehículo (VEH) o la melatonina 1 nM (MEL 1nM) y 100 nM (MEL 100 nM). En el panel 

izquierdo se muestran las imágenes de inmunofluorescencia, en particular, los canales 

correspondientes a la inmunodetección de los neurofilamentos (NF) como marcadores 

axonales en color azul y a la inmunodetección de MBP como marcador de mielina en color 

verde. En el panel central se muestran las imágenes que genera el plugin MyelinJ para el 

canal azul (NF) y a partir del cual se generan los datos del porcentaje de densidad axonal 

y en el panel derecho lo correspondiente al canal verde (MBP), a partir del cual se generan 

los datos del porcentaje de mielinización. 

 

Figura 7. Efecto de la 
melatonina sobre el porcentaje 
de mielinización. Los cocultivos 
fueron incubados durante 13 días 
con el vehículo (VEH), 
melatonina 1 nM (MEL1) o 
melatonina 100 nM (MEL100). La 
proteína MBP se detectó 
mediante inmunofluorescencia 
indirecta. Se representan los 
datos obtenidos del análisis de al 
menos 36 imágenes por 
tratamiento. ANOVA de una vía, 
prueba post hoc Tukey;  * p<0.05 
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Figura 7. Imágenes representativas de cada tratamiento aplicado a los cocultivos, 
analizadas con MyelinJ. El panel superior corresponde al vehículo (VEH), el panel central 

al tratamiento con melatonina 1 nM (MEL 1 nM) y el panel inferior al tratamiento con 

melatonina 100 nM (MEL 100 nM). El panel vertical izquierdo corresponde a la detección 

por inmunofluorescencia de axones (NF, canal azul), y de proyecciones oligodendrogliales 

y tractos mielinizados (MBP, canal verde). Análisis del porcentaje de densidad axonal (NF, 

panel vertical central). Análisis del porcentaje de mielinización (MBP, panel vertical 

derecho). 

 

DISCUSIÓN  
 

En el presente estudio se evaluó el efecto de la melatonina sobre la oligodendrogénesis y 

la mielinización in vitro. Para la evaluación de la oligodendrogénesis se analizaron 

imágenes de microscopía de fluorescencia de preparaciones de OPCs aislados de corteza 

cerebral de rata, que fueron incubados con melatonina en concentraciones fisiológicas de 

1 y 100 nM (Tan et al., 2016), o con el vehículo. Los resultados indican que en presencia 

de melatonina 1 nM, hay un aumento estadísticamente significativo (p = 0.002) en el número 

de células inmunopositivas a MBP con respecto del vehículo. La MBP se considera un 

marcador de diferenciación oligodendroglial porque se expresa en oligodendrocitos 

inmaduros y maduros, de acuerdo con la clasificación reportada por Barateiro & Fernandes 

(2014) ,y no en etapas previas (pre-oligodendrocitos y OPCs). Por lo tanto, los resultados 

indican que la melatonina, en la concentración presente en circulación (concentración 

fisiológica (Reiter, 1993)) induce la oligodendrogénesis.  Esto es consistente con un estudio 

previo de nuestro grupo de trabajo en el que se encontró que en OPCs obtenidos del nervio 

óptico o del hipocampo de la rata, el tratamiento con melatonina 100 nM induce un 

incremento significativo de la complejidad morfológica y del contenido de tubulina acetilada, 

ambos indicativos de diferenciación y maduración oligodendroglial (Rodríguez-Cárdenas, 

2019 (tesis); manuscrito en elaboración). Los resultados de dicho estudio sugieren que la 

melatonina puede incidir en la oligodendrogénesis mediante la modulación del citoesqueleto 

oligodendroglial.  

Nuestros resultados son consistentes también con el estudio de Ghareghani et al., (2017) 

quienes reportaron que en un rango de concentraciones de melatonina de 0.01-10 µM, hay 
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mayor viabilidad y proliferación de células madre neurales, y que en concentraciones de 

0.05 µM y 5 µM, la melatonina incrementa la diferenciación oligodendroglial. En dicho 

estudio, sin embargo, la concentración más baja que se evalúa es de 10 nM (0.01 µM) y se 

encuentra un efecto sobre la proliferación más que sobre la diferenciación oligodendroglial. 

De manera similar, en el estudio de Sotthibundhu et al., (2010) se observa que la melatonina 

modula la habilidad proliferativa de precursores neurales de la zona subventricular (la 

principal área neurogénica del cerebro adulto) en ratones adultos, en una forma 

dependiente de su concentración. En dicho estudio aplicaron concentraciones de 

melatonina de 0.001, 0.01, 0.1, 1 y 10 µM, en donde la más efectiva fue 1 µM, sin embargo, 

el efecto sobre la proliferación sufrió un decremento a una concentración mayor (10 µM). 

Además, reportaron la expresión de receptores de melatonina, específicamente MT1, en 

estas células. 

Esto puede deberse a que las células en las que evalúan el efecto son células madre 

neurales que todavía conservan la multipotencialidad para diferenciarse en neuronas o 

neuroglia (astrocitos/oligodendrocitos), mientras que en el presente estudio se utilizaron 

OPCs, ya comprometidos al linaje oligodendroglial (McCarthy & de Vellis, 1980).  

De acuerdo con Ramirez-Rodriguez et al., (2011) la melatonina puede modular la 

organización del citoesqueleto por el efecto que tiene sobre proteínas asociadas con la 

polimerización de microtúbulos a lo largo de las dendritas en neuronas del hipocampo. En 

relación con el presente estudio, se observó un incremento de las células inmuno-positivas 

a MBP, la cual está asociada con el citoesqueleto, ya que induce la polimerización de F-

actina y el agrupamiento de MF (Boggs, 2006). 

Olivier et al., (2009) describieron el efecto neuroprotector de la melatonina en una lesión de 

la materia blanca por hipoxia prenatal en el cerebro de rata. De acuerdo con sus resultados, 

la melatonina promueve la maduración oligodendroglial con una disminución en la 

activación de la microglía a una concentración de 1 µM, además, reportaron un aumento en 

la densidad de células MBP positivas en comparación con células que no fueron tratadas, 

y mencionan que obtuvieron resultados similares en una concentración de 100 µM. 

También, determinaron que los receptores MT1 y MT2 son expresados en astrocitos y 

microglía, y en menor medida en neuronas y oligodendrocitos inmaduros.  

En el estudio previo de nuestro grupo de trabajo (Rodríguez-Cárdenas et al. en preparación) 

se encontró que en una población enriquecida en OPCs A2B5(+) de hipocampo de rata, el 
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99% de las células expresa los receptores membranales de melatonina MT1 y MT2. Sin 

embargo, hasta el momento nuestro grupo no ha evaluado si los efectos de la melatonina 

observados en el estudio previo y el presente están mediados a través de dichos receptores. 

Al respecto, Biran et al., (2014), sugieren que los efectos neuroprotectores de la melatonina 

están en gran parte mediados por receptores específicos, más que en sus propiedades 

antioxidantes intrínsecas, además señalan tres líneas de evidencia que lo sugieren: (1) el 

antagonista de los receptores de melatonina, luzindol, suprime la neuroprotección inducida 

por la melatonina, (2) las dosis en las que se observan los efectos neuroprotectores de la 

melatonina son inferiores a las utilizadas generalmente para obtener un efecto antioxidante 

significativo, y (3) la melatonina protege contra las lesiones de la materia blanca pero no 

contra las lesiones de la placa cortical, mientras que la N-acetilcisteína, una molécula 

antioxidante típica, protege contra ambos.  

En este trabajo también se evaluó el efecto de la melatonina sobre la mielinización en un 

modelo in vitro. En el análisis de las imágenes correspondientes a las preparaciones 

tratadas con melatonina 100 nM, se observó un aumento estadísticamente significativo en 

el porcentaje de mielinización respecto al vehículo; en este grupo también se observó una 

disminución en la densidad axonal. Hasta donde sabemos este es el primer estudio en el 

que se aborda el efecto de la melatonina sobre la mielinización en un modelo de cocultivo. 

Además, los estudios previos utilizan modelos de daño a la materia blanca y 

concentraciones farmacológicas de melatonina. En nuestro estudio, las concentraciones de 

melatonina utilizadas son concentraciones fisiológicas, que pueden encontrarse en la 

circulación o en el líquido cefalorraquídeo durante la fase de oscuridad del ciclo de 

iluminación ambiental (Reiter, 1993; Tan et al., 2016). Si bien el proceso de 

oligodendrogénesis es indispensable para que ocurra la mielinización, en ésta están 

involucradas diversas señales solubles y de contacto celular entre el axón y los 

oligodendrocitos (Dermitzakis et al., 2022; Fekete & Nishiyama, 2022). En el SNC, gran 

parte de estas señales son inhibitorias, por lo que un fármaco que induce la 

oligodendrogénesis no necesariamente induce también la mielinización. Nuestros 

resultados indican que la melatonina induce tanto la oligodendrogénesis como la 

mielinización, en concentraciones fisiológicas. 

Las perspectivas de continuación de este trabajo incluyen evaluar el efecto de la melatonina 

en un nivel mayor de complejidad, en modelos ex vivo de cultivos cerebrales organotípicos 

y comenzar a dilucidar el mecanismo de acción que subyace a los efectos de la melatonina, 
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es decir, si dichos efectos están mediados por sus receptores de membrana y qué vías de 

señalización intracelular están involucradas. 

CONCLUSIONES 
 

La melatonina induce la oligodendrogénesis y la mielinización en modelos in vitro. La 

influencia sobre la fisiología oligodendroglial, se suma a los efectos ya reportados de la 

melatonina como un modulador clave de los procesos involucrados en el desarrollo y la 

plasticidad del sistema nervioso central. 
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